3-D ANIMATED ADVENTURE GAME
REFERENCE CARD (SCl) FOR THE ATARI ST

Sierra’s 3-D Animated Adventures represent a new generation of computer gaming
Advanced features such as high resclution graphics, state-of-the-art animation and a
powerful parser combine to make adventure games that are the closest thing yet 10
real life.

GETTING STARTED -- FLOPPY DISK INSTALLATION

If you are playing from floppy disks, formatl one or more disks for saving games, We
also recommend that you format one disk for each game disk and make back-up
copies of your program masters,

To format a disk, place the new disk in drive A, single-click on the drive A icon, then
select Formal from the File menw and follow the prompts. Choose “Double-sided"
from the FORMAT dialog to make copies of your program masters. Choose either
"Double-sided"” or "“Single-sided”” to format Save Game disks.

MAKE BACK-UP COPIES OF PROGRAM MASTERS (TWO DRIVE SYSTEMS)

1. Place the first game disk in drive A, and a blank formatted disk in drive B.

2. Copy the game disk to the back-up disk by dragging the drive A icon onto the
drive B icon. {Click on the drive A icon. While holding the mouse button down,
mova the mouse arrow over the drive B icon, then release the button.) Click on
KT,

Click on “COPY"".

Take out both disks, and label the back-up disk

Rapeat steps 3-4 for each of the game disks, using a different blank disk far

each back-up copy.

6. Put the master disks away in a safe place, and play the game only from the
back-up copies.

MAKE BACK-UP COPIES OF PROGRAM MASTERS (SINGLE DRIVE SYSTEMS)

1. Place the first game disk in the disk drive.

2. Copy the game disk to the back-up disk by dragging the drive A icon onto the
drive B icon. (Click on the drive A icon, While haolding the mouse button down,
move the mouse arrow over the drive B icon, then release the button.) Click on
L

3. Click on "“"COPY".

4. Each time you see a prompl that says “Please insert disk & into drive A7,
place the program master disk into the disk drive. Each lime you see "Please
insert disk B into drive A", place the back-up (blank) disk into the disk drive.

5. Take out the disk, and label the back-up disk,

6. Repeat steps 3-5 for each of the game disks, using a different blank disk for
each back-up copy.

7. Put the master disks away in a safe place, and play the game only from the
bhack-up copies.
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GETTING STARTED -- HARD DISK INSTALLATION

1. If you are playing from a hard disk, first make sure you have enough space on
tha hard disk for the game - single-click on the disk icon, then select Show
Info from the File menu. Byltes Available should be at least BOO,000 times the
number of floppy disks included with the game.
Open the hard disk by double-clicking on its icon,
Craate a gama foider by choosing Mew Folder from the File menu, Open the
new folder by double-clicking on its icon.
Place the first game disk in drive A
Copy the game disk into the new folder by dragging the drive A icon into the
window you opened in Step 3. (Click on the drive A icon while halding the
mouse button down. Move the mouse arrow over the open window, and releases
the buttan.)
6. Repeal steps 4 and 5 for each of the other game disks.
7. Put the master disks away in a safe place.
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CHOOSE A MUSIC DEVICE (Optional)

“our Sierra game is initially set up lo play music and sounds through the Atari ST's
internal speaker, If you have one of the supported MID| synthesizers, you may run
the MUSIC program to have the game play music through the synthesizer.

1. Open the game diskfolder by double-clicking on its icon.

2. Run the MUSIC program by double-clicking on the MUSIC.PRG icon,

3. Select ""Music Device™ from the Options menu.

4. Select your synthesizer (or “'Atari 5T Intarnal Sound™) by clicking on the
appropriate button. Click on OK,

E. Select "Install Game" from the File menu. This will replace the

RESOURCE.CFG file on your disk,

Please Note: It is important to turn your synthesizar on before playing the game.

LOADING INSTRUCTIONS
Flease nots: if you are using an Atari 520 ST without memory expansion, you should
not run your Sierra game with any desk accessories installed.

If you are playing the game from floppy disk: Place disk 1 in drive A, cpen the disk by
double-clicking on its icon, then start the game by double-clicking en SIERRA.PRG.

It you are playing the game from a hard disk: Open the disk by double-clicking on its
icon, then open the game folder by double-clicking on the game folder icon, Start the
game by double clicking on SIERRA.PRG.



THE PULL-DOWN MEMUS

WMaost of the functions you will need to use while playing this game can be accessed
using the pull-down menus,

To access the menus with the mouse:

1. Press the left mouse button while the mouse curser is in the siatus line. The

menu will appear. As long as you keep the mouse button prassad, you will be
able to examing the contents of the various menus. To select a menu option just
releasa the button while a given option is highlighted.
EXAMPLE: If you highlight SAVE GAME from the FILE menu, a window will
appear requesting you 1o type the description of the saved game. If you decide
not io make a selecticn, move the mouse cursor away from the menus and
release the button.

To access the menus with the keyboard:
1. Press ESC to make the menus appear.
2. Use the arrow keys to highlight the desired action from a mend.
3. Press EMTER to select the desired action,
If you decide not to make a selection, press ESC instead of ENTER.

WINDOWS

When a menu item is selected, a dialog window appears, Dialog windows are used
for typing commands or making selections. To move the cursor within the window,
use the mouse or the arrow kays. You may also use the HOME or END keys to move
the cursor to the beginning or end of a line, Type CTRL-C 1o clear the line {if you
make a mistaks, wish to rename a file, ete.).

Windows may contain command buttons, To perform a command with a mouse,
select the desired command button and click the left mouse button, To perform a
command with the keyboard, use the TAB and SHIFT-TAB keys to move betwesn
choices. Press EMTER to select a command. Press ESC to cancel the command.

MOVING ¥YOUR CHARACTER

You may move your character on the screen with the arrow keys, the numeric
keypad, or the mouse. To halt your character's steps with the keypad, press the
number &, or press the last used direction key again. Using the mouse, stan
movemeant by clicking the left mouse where you want the character 1o move.
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INTERACTING WITH THE GAME
You interact with the game by typing in commands of one or two words, or in
complete sentences. Fellow all commands with ENTER.

EXAMPLES OF COMMON COMMAMNDS:

You may mest characters who have messages for you. Start a conversation with
thern, Type: TALK TO (whoever you wish to talk to). For example, TALK TO THE
AMGHY PIRATE.

You may encounter ocbjects you need along the way. To take an cbject tvpe: TAKE
(the object you want to take). For example, TAKE THE SILVER CHALICE.

Pay close attention 1o details. Take a close look at objects. Type: EXAMINE (the
object you wish to examine). For example, EXAMINE THE DUSTY TREASURE
CHEST.

You will need to use the objects you acquire on your journey. Typa: GIVE THE
(ocbject) to (the person or thing you wish to have the object). For example, GIVE THE
BOME TO THE HUNGRY TIGER.

RETYPING COMMANDS
If you wish to repeat a command select RETYPE from the ACTION menu-or press
the SPACEBAR.

INVENTORY

If you wish to see the items you are carrying, select INVENTORY from the ACTION
menu or press the TAB key. A list of the items you are carrying will be displayed. To
view an object, ¢lick on its name with the mouse, or use the arrow keys to highlight
the name and press EMNTER. Select OK or prass ESC key 1o resume play,

PAUSING YOUR GAME
If vou wish to pause the game, select PAUSE from the ACTION menu. Press ESC or
EMTER to continue play.

SAVING AND RESTORING GAMES

To allow for errors in judgment and creative exploration, it is recommended that you
frequently save your game in progress. You will always want 1o save your game
before encountering dangercus situations. You should also save your game after
you have made significant prograss in the game.

Fiease Mote: If you're playing from floppy disks, you must have a formatied save
game disk hefore you can save a game.

You may name your saved games using standard English phrases. For example, if
you are standing on a sandy beach, call your saved game "STANDING ON A
SANDY BEACH", or whatever sgams appropriate.



SAVING YOUR GAME {Single Floppy Disk Drive Users)

1,

Salect SAVE GAME from the FILE manu.

2. You will be prompted to insert your SAVE GAME disk in drive A:. Follow the

prompt by replacing your game disk with a formatted disk on which your game
may be saved. Select OK or press ENTER.

3. Type the description of your saved game. Select SAVE or press ENTER to save

the game. If you change yvour mind and do not wish 1o save tha gamae, selact
cancel ar press ESC. After the game is saved, yvou will be prompted (o reinsart
your game disk in drive Az

SAVING YOUR GAME (Twa Floppy Disk Drive Users)

i

Saelect SAVE GAME from the FILE menu.

2. You will be prompted to insert your SAVE GAME disk in drive A Select

CHAMNGE DIRECTORY. Type CTRHL-C 1o clear the dialog window and enter B:,
Insert your SAVE GAME disk into the B: drive. Select OK or press ENTER.
Type the description of the saved game in the dialog window. Select SAVE or
press ENTER to save the game to the directory you are currently playing on. If
you change your mind and do not wish (o save the game, select cancel or press
ESC.

After the game is saved, play will resume.

Please MNote: Leave your save game disk in drive B: for future saves.

SAVING YOUR GAME (Hard Disk Users)

1,

Select SAVE GAME from the FILE menu.

2. Type the description of the saved game in the dialog window. Select SAVE or

press ENTER to save the game to the directory you are currently playing on. If
you changs your mind and do not wish te save the game, select cancel or press
ESC.

If you wish to save the game to a directory other than the one yeu are playing on,
select CHAMGE DIRECTORY. Type CTRL-C to clear the dialog window and
entar the name of the directory on which you wish to save the game. Select OK
or press ENTER. Play will resume after the game has been saved.

Please Mote: All future games will be saved on this directory until a new
CHAMGE DIRECTORY command is used.

RESTORING YOUR GAME
Select RESTORE from the FILE menu. You will be prompted to select the game you

wish to restore, (On a single drive system, you will be prompted to insert your save
game disk.) Highlight the desired game and select RESTORE. If the game you wish
to restore is on a different directory, select CHAMGE DIRECTORY.

QUITTING YOUR GAME
If you wish o stop playing, select QUIT from the FILE menu.
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SOUND CONTROLS

To turn off the sound, select TURN OFF from the SOUMD menu. To turn the
sound back on selact TURM O,

To adjust the volume, select VOLUME from the SOUND menu {or simply use the
volume eontrol on your monitor). When you have selected the desired volume, salect
OK or press ENTER. Select NORMAL and select OK to return 1o standard volume.
Select CANCEL if you change your mind and wish to return to the game.

Please Note: The valume control will not work with some synthesizers,
SHORT CUTS FOR COMMOMN COMMANDS
You can use function and control keys to short cut many commaon commands.

F1 Help screenfMenus: Lists game instructions
fincluding same specific to your game which may not
be mentioned hera)

F2 Toagle sound (on or off)

F3 or SPACEBAR Echo {repeat) previous command
F5 Save game

F7 Restore game

Fa Restarl game

Function keys F4, F&, F8 and F10 may be used tor specific functions in your game.
Refer to the game menu or your instructions,

Control | or TAB Imventary
Contral P Pause game
Control O CQuit game
Contral § Speed adjustment
OR
— key Slowar
= kay Mormal
+ key Faster
Contral W Yalume adjustment for sound
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The only source for KING’S QUEST IV HINTS!

THE OFFICIAL BOOK OF KING’S QUEST-
DAVENTRY AND BEYOND!

dhe Official Book of King's Quest - Daveniry and Beyond is the perfect
collector’s item for all King's Quest fans young and old. Packed with

informative histories, detailed maps, and helpful hints to cach game in the
King's Quest series, this is the definitive book /("“—h-——_.______ |
for adventure game players. / e
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B The making of King's Quest IV--an insider’s lfl / OF‘P |"
look at the creation of Sierra’s prandest I/ I ICIAL [
adventure game ever! III {
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B Complete score charts--discover the U o
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B Answers o the most frequently
asked questions about the King's Cuest
series!
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To receive your very own copy of
The Official Beok of King's Quest,
fill out the coupon below:

THE OFFICIAL BOOK OF
KING'S QUEST
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